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How do I activate the LexisNexis®  PatentOptimizer™ Service?
You must activate the LexisNexis®  PatentOptimizer™ service before using the service for the first time or subsequent to
service deactivation. You must have an active Internet connection to activate the service.

1. Open the Microsoft®  Word, Internet Explorer, Adobe Acrobat® , or Adobe Reader®  program as you normally would.
The applicable program opens, displaying the LexisNexis PatentOptimizer in the upper portion of the program
window.

Note:
The first time you open the Microsoft Word application after installing the LexisNexis PatentOptimizer service, you
may receive a warning message asking whether you want to enable related macros.

\ use the two applications in conjunction with each other, select the Always trust macros from this source
check box, then click the Enable Macros button. This installs the LexisNexis PatentOptimizer toolbar in the
Microsoft Word software.

For more information on how to handle macro security, consult your Microsoft Word documentation.

2.
On the LexisNexis PatentOptimizer toolbar, click any button other than Options ( ) or Help ( ). The Lexis User
ID and Password dialog box opens.

Note:
For a list of toolbar buttons, see How do I access service features?.

3. Enter your LexisNexis®  User ID and Password.

4. Click OK. The dialog box closes and the LexisNexis PatentOptimizer service launches the feature you selected at 2.

Note:
If you subsequently want to use the service on a different computer, you must first deactivate it on the current
computer (see How do I deactivate the Service?) then install and activate it on the other computer.
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How do I access service features?

You can access the LexisNexis®  PatentOptimizer™ features in several ways, specifically using the toolbar, using the
Tools>LexisNexis PatentOptimizer menu, or using the right-click menu.

To access service features using the toolbar, click the applicable button.

Tip:
The LexisNexis PatentOptimizer toolbar is available in Microsoft®  Word, Internet Explorer, Adobe Acrobat® , and
Adobe Reader® , although a few buttons are only available in Microsoft Word. To view a description of any toolbar
button within the application, rest your pointer on the button for several seconds.

Button Command

PatentOptimizer™ Summary Report

Check References

Check Terms

Mark Terms

Check Measurements

Check Parts

Check Claims

Compare Docs

PatentOptimizer™ Analytics (available in Word and Internet Explorer only)

LexisNexis®  Patent Research

Web Search

Dictionary

Thesaurus

Patent Citation (available in Word only)

Mark Claims Wizard (available in Word only)

Update Claim References (available in Word only)

Remove Markup (available in Word only)
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Button Command

Options

Assign Applicable Client Matter ID

Feedback - see How do I submit feedback? for information on using this new feature.

Import Data (available in Adobe Acrobat®  and Adobe Reader®  only)

Help

Tip:
Most program features are also available from the Tools>LexisNexis PatentOptimizer menu, and some are
available using the right-click menu (as described in the following procedure). The Remove Markup feature,
however, is only available from the toolbar.

To access service features using the menu:

Tip:
Certain program features are only available in Microsoft Word and only from the menu, with the Mark Claim

Number ( ) and Mark Claim Reference ( ) features being available from both the Tools>LexisNexis

PatentOptimizer menu and the right-click menu and the Term Variants feature ( ) being available only from
the right-click menu. Access to program features using the menu is not available in the Internet Explorer program.

o From the Tools menu in the Microsoft Word, or Acrobat, or Reader program, choose LexisNexis
PatentOptimizer followed by the applicable feature (see How do I launch LexisNexis®  PatentOptimizer™
features using the toolbar?).

Note:
The Tools>LexisNexis PatentOptimizer menu varies slightly between programs, with the version in the
Adobe Acrobat®  and Adobe Reader®  programs containing a subset of the features offered using the
Microsoft Word version.

o Right-click anywhere within a Microsoft Word document, then from the displayed menu, choose LexisNexis
PatentOptimizer followed by the applicable feature (see How do I launch LexisNexis®  PatentOptimizer™
features using the right-click menu?).

Note:
The right-click menu contains a subset of the features offered in the Tools>LexisNexis PatentOptimizer
menu and is not available in the Acrobat and Reader programs.
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How do I submit feedback?

1.
On the LexisNexis®  PatentOptimizer™ toolbar, click the Feedback button ( ). The LexisNexis®

PatentOptimizer™ Feedback dialog box opens (as shown below).

2. Enter your Email Address.

3. Select Request Contact if you want a LexisNexis representative to contact you.

4. Select a Product Feature from the drop-down list.

Tip:
If you are unsure of the product feature, choose Other.

5. Enter your Comment/Request.

6. Click OK to submit only the information you provided on this form to LexisNexis.

Thank you for taking the time to provide us with your feedback.
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How do I find out more about a selected term?
1. In your patent document, select the words to be searched.

Tip:
For a single word, you can just be pointing to the word you want to search. You can also double-click on a word
to select the entire word at a time, or triple-click to select an entire paragraph.

2. Click the applicable toolbar button to perform these task:

To... Click this button

Find a definition
 Dictionary

Find a synonym
 Thesaurus

Search the Web for terms
 Web Search

Tip:
You can also initiate these tasks using the Tools>LexisNexis®  PatentOptimizer™ menu or the right-click menu.

3. Select a dictionary, thesaurus, or search engine from the list to the right.

Tip:
To block pop-up windows when using these features, select Block Pop-ups.

Tip:
To navigate among multiple results, click Back or Forward.
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How do I replace a word with a synonym?
Important:
This task can only be performed in a Microsoft®  Word document.

Tip:
To replace a word using only LexisNexis PatentOptmizer sources, use the Term Variants feature available from the
right-click menu.

 

1.
Select Thesaurus ( ) from a LexisNexis®  PatentOptimizer™ menu or toolbar.

2. Highlight the synonym that you want to use instead of the word currently selected in your document.

3. Click Replace. The word you have selected is passed to the Microsoft Word Find and Replace feature, where you
may proceed as you normally would when finding and replacing text in that program.
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How do I highlight terms used in a patent document?
1.

Select Mark Terms ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Set the options as desired.

3. Click OK to proceed with marking the terms in your document.

Tip:
To unmark the document, repeat step 1 of this procedure.
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How do I view identified terminology and reference sources?
1.

Select Check Terms ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Choose which tab you want to use:

Use the Search Terms tab to view identified terms and phrases one at a time.

Use the All Terms tab to view a table of all identified terms and phrases.

Tip:
To navigate to the location of an identified term or phrase in your patent document from the All Terms tab, click
the term or phrase in the displayed table.

3. View reference information for identified terminology and perform additional related actions, as follows:

Click the blue patent numbers in the Prior Usage tab to access existing patents containing the identified term
or phrase.

Click the reference link in the Case Refs tab to view the full text of cases referencing the identified term or
phrase.

View custom definitions from user-created dictionaries using the Definitions tab.

Select a term in the Alternate Terms tab and click Replace (located on the Search Terms tab) to replace the
original term.

Designate terms and phrases for inclusion in a report by either double-clicking the term (if working on the All
Terms tab) or selecting the Add to Report check box (if working on either tab).
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How do I search the LexisNexis®  Total Research System for patents
containing identified terminology?

1.
Select Check Terms ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Select the desired term or phrase

By... If working on this tab

Navigating to it Search Terms

Clicking it All Terms

3. (Optional) Filter results by a U.S. patent classification number by entering that number in the Class field.

4. Click the appropriate button for the type of information you're searching for:

To search... Click this button

Complete patent content
regardless of granting date

General

Only claims sections of
patents granted in the past
6 months

Recent Claims
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How do I check Title and Abstract length?
1.

Select Check Terms ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Click the Text Format tab. The tab displays the character and word counts for the title and abstract sections,
beside which are listed the maximum allowable counts as determined by the USPTO, and below which is shown the
actual text of the currently selected analyzed section (i.e., abstract or title), with any material extending beyond the
maximum allowable length highlighted in red.
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How do I manage ignored terms?
1.

Select the Options ( ) toolbar button.

Tip:

Or select Check Terms ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu and then
click the Options button in the Check Terms dialog box.

2. Click the Ignored Terms tab.

3. Perform the desired maintenance activity, as follows:

To put a new word on the ignored terms list, type the word in the entry box, then click Add.

To clear a word from the ignored terms list, click the word within the list, then click Remove.

To clear all words from the ignored terms list, click Remove All.

4. Click OK to save your input and close the dialog box.



LexisNexis® PatentOptimizer™ Quick Reference Card 09-27-2012

12

How do I use the PatentOptimizer™ Analytics feature?
Before You Begin:
You must have access to this dialog box to perform this task. If you do not have access to this feature, a pop-up
window will be displayed when you click the button, informing you of this fact. Contact your Customer Support
representative if you would like to activate the Analytics feature.

Use the PatentOptimizer™ Analytics feature to run an analytics profile for U.S. utility patents and PCT applications
meeting your specific criteria (the cite list you've searched for, predetermined patent citations, or local documents you've
imported). Once you click the Profile tab, you can interact with the subsequent filter (those across the top of the dialog
box) and view (those across the bottom) tabs to refine what you're seeing, and then run a Report, Claim Chart, or Check
Refs on your results.

Note:
On occasion the LexisNexis®  PatentOptimizer™ tool will not be able to process or parse some patents. When this
occurs, a pop-up window will appear just after all processing has completed, listing all of the patents that were not
processed.

1. Open a patent document.

2. Click the Analytics button ( ) on the LexisNexis PatentOptimizer toolbar of Microsoft®  Word or Internet Explorer.

3. Determine which patents you want to analyze:

You can... By...

Enter patent citations
directly in the Patents
area

Click directly into the Patents box, then type or paste a previously copied list of
patents into the box.

Search for patents using
the Search tab

Enter one or more filter criteria onto the Search form, then click the Search button.
For example, if you wanted to find 25 patents associated with Google, you would:

a. Select "25" from the Max Docs drop-down list

b. Enter "Google" in the Assignee box

c. Click Search

Refer to the PatentOptimizer™ Analytics dialog box for descriptions of each search
option.

Import documents using
the My Documents tab

Follow these steps:

a. Click the My Documents tab

b. Select the number of maximum documents you'd like from the Max Docs drop-
down list

c. Click the Import button

d. Use your operating system's folder selection tool to select the folder where your
patent documents are stored

e. Click the OK button

Open a set of previously
saved patents

Click the Open button and choose the set you want to use.

Save the patents you're
viewing for future use

Click the Save button.

4. Remove any items you do not want to analyze from the Patents box by selecting and deleting them.
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5. Click the Run Analytics Profile button when you are ready to analyze the listed Patents. A performance warning
message displays to alert you that all parts, claim elements, terms, phrases and citations found in only one patent
will not be shown. Click OK to continue.

Tip:
To increase performance speed and performance, and disable this warning message, reduce the number of
patents to be analyzed, or navigate to the Options tab and adjust the Optimize Results setting.

6. Click the Profile tab.

7. Use the filter tabs (those across the top of the dialog box) and their check boxes displayed to select different items to
filter your results.

Example:
For instance, if you want to see only those patents that have a specific Assignee, Part, and Thesaurus Term/
Phrase, you would:

a. Select the appropriate Assignee check box on the People & Org filter tab

b. Select the Specification filter tab

c. Select the check box for the Part you're interested in

d. Select the Thesaurus filter tab

e. Select the check box associated with the Term/Phrase you're interested in, then select any Term/Phrase
Variants that are appropriate

Notes:

Click the Selection Summary filter tab to see all of the different selections you've made

Click the Clear All button to clear all of the selections you've made and start again

Click a column heading to sort that column's contents, then type a letter to find that letter within the sorted
column.

Tip:
Clicking once sorts in ascending order (A-Z or 1-10); clicking a second time sorts in descending order (Z-A
or 10-1).

Filters selected in multiple filter tabs are ANDed together; within each filter, selections are ORed

Use the Select All and Deselect All buttons at the bottom of the dialog box to select or clear all of the items
currently displayed in the view tabs (those across the bottom of the dialog box)

Select the Filter Counts Only check box to display only the number of items available with the filters applied,
not the total number of items available

8. Choose your next action:

If you want to... Then...

Run a PatentOptimizer™
Analytics Report...

a. Click the Report button

b. Select Analytics Report

c. Select which type of items you want to include: All Items; Filtered Subsets;
Selected Items Only; Selected Pubs/Docs

d. Use the check boxes to select which worksheets you want to include in your
report

e. Click OK

Run a Claim Chart report... a. Click the Claim Chart button
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If you want to... Then...

b. Use the options and check boxes to specify how you want your report to be
generated

c. Click OK

Check references for the
items you've selected...

Click the Check Refs button, and continue with one of the tasks available for that
page, as shown in the How Do I...? box within the help system.

9. Click the Close button when you are finished using this dialog box.
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PatentOptimizer™ Analytics

Use the PatentOptimizer™ Analytics feature to run an analytics profile for U.S. utility patents and PCT applications
meeting your specific criteria (the cite list you've searched for, predetermined patent citations, or local documents you've
imported). Once you click the Profile tab, you can interact with the subsequent filter (those across the top of the dialog
box) and view (those across the bottom) tabs to refine what you're seeing, and then run a Report, Claim Chart, or Check
Refs on your results.

You can launch the PatentOptimizer™ Analytics feature by clicking the Analytics button ( ) on the LexisNexis

PatentOptimizer toolbar of Microsoft®  Word or Internet Explorer.

Note:
If you do not have access to this feature, a pop-up window will be displayed when you click the button, informing you of
this fact. Contact your Account Representative if you would like to activate the Analytics feature.

Common Buttons and UI Elements

The common buttons appear at the bottom of the dialog box.

Tip:
You can combine at least 2 items in any category of information (e.g., People & Org > Assignee, or Inventor, or Legal
Rep) to make the display less cluttered. To combine them, select at least 2 check boxes, then right-click and select
Combine Selected from the resulting menu. Then choose the label you want to use for these combined items and
how long you want this substitution to remain in effect ("This Session Only" or "Permanent"). To undo the combination,
click the Options subtab for Analytics, then either click the Remove All button to remove all combinations, or select
one combination then click the Remove button to remove it.

Value Description

Select All Click this button to select all of the items listed in the selection table at the bottom of the
Profile tab.

Deselect All Click this button to clear all of the check marks from the items listed in the view tabs at
the bottom of the Profile tab.

Report Select Analytics Report to open the PatentOptimizer™ Analytics Reports dialog
box, or select Pub/Doc Summary to open the PatentOptimizer™ Analytics Summary
Report. Select the items that you want in the report, and select any filters to be used in
creating your report in a new Microsoft®  Excel or Microsoft Word window.

Claim Chart Click to open the Claim Chart dialog box, then select which options you'd like to include
in this report in a new Microsoft Excel or Microsoft Word window.

Check Refs Click to open the Check References dialog box.

Tip:
if you haven’t selected any patents, then all patents will be analyzed.

Close Click to close this dialog box.

Help Click to view help specific to this feature.

Source tab

The source tab identifies sources for patent data to be analyzed. You can provide your own list of patents (with or without
titles), specify a file folder for patents, or run a search based on criteria you enter.
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The following image shows the Analytics dialog box displaying the Source tab before a search has been run.

Once you enter the values you want to search on and click the Run Analytics Profile tab, the Patents that match your
search criteria are displayed.

The following image shows the Analytics dialog box displaying the Source tab after a search has been run.
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Value Description

My Documents tab This tab allows you to import up to 1,000 Microsoft®  Word documents to be analyzed.

Open Click to retrieve a list of sources you've previously saved.

Save Click to save the sources listed, so you can open them and work with them again later.

Import Click to Browse for a folder that contains the patents you'd like to analyze, then click OK
to complete the import.

Tip:
Once you have imported the documents, you can select and delete individual
documents before you click the Run Analytics Profile button.

Search tab This tab allows you to enter search criteria to find patents whose profiles you want to
view.

Open Click to retrieve a list of sources you've previously saved.

Save Click to save the sources listed, so you can open them and work with them again later.

Search Click to search for patents that meet all of the criteria you've entered. You must click this
button before clicking the Run Analytics Profile button.

Clear Click to clear all of the criteria you've entered.
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Max Docs Select a value from the drop-down list. The fewer documents you analyze, the faster the
analysis will be run. Choosing a larger number may result in an error message being
displayed when you click the Run Analytics Profile button to warn you that some items
may not be shown in the results.

Doc Type Select a value from the drop-down list:

All

Granted

Applications

Authority Select either or both of these options:

US - United States

WO - World Intellectual Property Organization (WIPO)

Class Enter the main U.S. patent classification number in this box to limit the range of your
search to a particular class/subclass of patents.

Tip:
Identify subclass with a # sign.

Example:
229#112

IPC Enter the International Patent Classification number.

Tip:
Identify subclass with a # sign.

Example:
B65D 043#14

Assignee Enter a person or company name for the assignee at issue.

Legal Rep Enter the name of the legal representative (individual or company name).

Inventor Enter the name of an inventor.

Ref Cited Enter the citing reference you want to find.

Date Range Select a predefined date restriction from this drop-down list:

No Date Entered

Previous Week

Previous Month

Previous 3 Months

Previous 6 Months

Previous Year

Previous 2 Years

Previous 5 Years

Previous 10 Years

Date From Select the option for From date, then choose the date you want to use by either:

Entering the date in the box in MM/DD/YY format
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Clicking the corresponding calendar button ( ) and selecting a date

Date To Select the option for From date, then choose the To date you want to use by either:

Entering the date in the box in MM/DD/YY format

Clicking the corresponding calendar button ( ) and selecting a date

Run Analytics Profile Click to analyze the displayed Patents.

A performance warning message may display to alert you that all parts, claim
elements, terms, phrases and citations found in only one patent will not be shown

Click OK to continue.

Important:
The analysis takes about 1 second per patent.

Tip:
To increase performance speed and performance, and disable this warning message,
reduce the number of patents to be analyzed, or navigate to the Options tab and
adjust the Optimize Results setting.

Cancel Click to cancel a Run Analytics Profile command.

Patents Lists the patents you entered, that were found when you clicked the Search button on the
Search tab, or that you Imported on the My Documents tab.

Tip:
When you enter patent numbers directly into this box, they must be entered on
separate lines to be correctly detected by the tool.

Important:
Review the patent citations listed in this box, then select and delete any items you do
not want to include in your analysis.

Summary Reflects totals and averages of the analyzed data:

Item - Lists the type of item that was analyzed (e.g., Claims, Inventors, Examiners)

Average - Lists the average number for each item

Total - Lists the total number for each item

Unique - Lists the number of unique instances for each item

Profile Tab

The profile tab contains the patent analysis results.

The following image shows the Analytics dialog box displaying the Profile tab.
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Value Description

Clear All Click this to clear all selections made across all of the Profile filter tabs.

Filter Tabs

The filter tabs across the top are joined together with Boolean AND logic; within each filter, selections are ordered. All hits
are identified with total counts, in rank order (highest to lowest). Selecting a value results in filtering of data in the bottom
half of the display. The filter data not contained in an answer set in the filter tabs is grayed out.

Tip:
To apply "AND" logic within each filter tab as well as across filter tabs, select the Apply "AND" Logic check box in the
Options filter tab.

For example, selecting options from the different filters across the top treats each additional selection as a
Boolean AND.

New!  Auto sorting now takes place after you select a check box. That is, when you select a check box from anywhere in
the list, it automatically moves to the top of the list.
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Example:
Selecting multiple check boxes within a single filter treats each additional selection as a Boolean OR.
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Value Description

People & Org Displays check boxes and Count [Cnt] columns as applicable for the patents being
analyzed. For example:

Assignee

Inventor

Legal Rep

Examiner

Auto-Sort Filters

Class & Date Displays check boxes and Count [Cnt] columns as applicable for the patents being
analyzed.

Tip:
If you rest your pointer over a value in the US Class column, the description for that
class (and subclass) will be displayed. To control whether both the class and subclass
or just the class is displayed, click the Options tab and select your desired display
option under US Class Display.

US Class

IPC

Filed Date



LexisNexis® PatentOptimizer™ Quick Reference Card 09-27-2012

23

Pub Date

Auto-Sort Filters

Specification Displays check boxes and Count [Cnt] columns as applicable for the patents being
analyzed. For example:

Parts

Terms

Phrases

Citations

Auto-Sort Filters

Claim Elements Displays check boxes and Count [Cnt] columns for aggregate claim elements across all
of the profiled documents. For example:

Claim Elements, with Variants (which are algorithmically derived from your selected
portfolio of patents)

Tip:
If you select a Claim Element that has Variants, the table to the right lets you
select any Element Variants you wish.

Use these options at the right to further filter your results, if desired.

Limit Element Variants to Doc Claim Language

Locate and Display within
o All Claims - identifies documents when selected elements appear anywhere in

the claim set
o Independent Claims - identifies documents when selected elements appear

anywhere in a single independent claim
o Auto-Sort Filters - automatically sorts results, placing the most relevant results

at the top of the list

Definitions Displays check boxes and Count [Cnt] columns for Term and Definition columns.
The Definitions provided here are mined from express glossaries contained in various
patents. These glossaries typically have a heading (such as GLOSSARY :) followed by a
series of terms with definitions.

Auto-Sort Filters - automatically sorts results, placing the most relevant results at the top
of the list

Thesaurus Displays check boxes and Count [Cnt] columns as derived from parts data located in your
selected patent portfolio. For example:

Term/Phrase, with Variants

Tip:
If you select a Term/Phrase that has Variants, the table to the right lets you
select any Term/Phrase Variants you wish.

Auto-Sort Filters - automatically sorts results, placing the most relevant results at
the top of the list

Thesaurus items are determined by identifying parts having name variants for the same
part number as across multiple patents.
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Selection Summary Displays summary check boxes for viewing selections and overriding individual filters. For
example:

Selection

Attribute

Auto-Sort Filters

When you select or clear one or more of the Sel check boxes, a dialog box appears
when you try to leave this tab, asking you if you want to "Update filters with selection
changes?". Click Yes to save the changes you've made.

Options Select from the following options, as desired:
Filters

Counts | Filter Counts Only - Select to reflect counts that identify the subset defined
by your filter selections

Specifications > Terms | Ignore Common - Select to ignore common terms
appearing in terms filter

Standardization | Enable - Select to enable entity standardization across filters

US Class Display | Class or Class/Sub-Class - Select to enable US class display
filters or display class/subclass filters

Apply "AND" Logic - Select one or more check boxes for the type of filter (List) to
which you would like to have AND logic applied, instead of the typical OR logic
within each filter tab

Combined Entities

Caution:
The changes you make will be reflected in your next session - not in the current
Profile results

o <Add> - Select to add a new combined entity
o Edit - Select an item in the list, then click to modify that combined entity. The

Combine Entities dialog box has these options:
- <Add> - Select to add a new combined entity
- OK - Click this button to save the changes you've made and exit this

dialog box
- Cancel - Click this button to cancel the changes you've made and exit

this dialog box
- Edit - Click this button to modify the name of the item you selected
- Delete - Click this button to remove the item you selected from the list of

combined entities
- Duration - Select either Permanent or This Session Only

o Delete - Select an item in the list, then click to delete that item

Global

Optimize Results - Select one of these options from the drop-down list:

Optimize Results option

Maximum Documents value can be applied to:
o None
o >0 - 24
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o Ignore Single Count
o 25 - 249
o Ignore 2 or Less
o 250 - 499
o Ignore 3 or Less
o Ignore 4 or Less
o 1000-1500
o Ignore 5 or Less
o 1500-2000

Cache Offline - Click the checkbox to cache from your local disk drive, instead of
caching records from a server

Clear Cache - Click the checkbox to remove all saved patent data from the
Analytics feature

Views
o Independent Only - select the Independent Only check box to view

independent claims only in the Claims view tab
o Add Part Nos. to Claims

Tip:
Since data will accumulate on your disk drive, you should clear the cache periodically
to increase performance speed and decrease disk space usage.

View Tabs

The view tabs show the results you get once you have applied filters using the filter tabs at the top of the dialog box.

Select one or more check boxes in the view tabs that you want to run a Report, Claim Chart, or Check References on.

Value Description

Cite Select one or more items based on the columns displayed:

Pub Number - Publication Number

Title

IPC

Assignee

Granted Date

The documents displayed are subject to your selections in the filter tabs.

Examination Data Select one or more items based on:

Pub Number - Publication Number

Title

US Class

Legal Rep - Legal Representative

Inventor
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Examiner

Ind Clms - Independent Claims

Claims

Claims Select one or more publication numbers, then use the Claim Tree and Claim Text boxes
to the right to navigate and view the associated claim hierarchy and text.

Full Text Select one or more publication numbers, then use the box to the right to review the full
plain text for your selections.

Images View and manipulate thumbnail images that are available within the selected patent
documents:

o US documents have thumbnail and drawing sheets available
o PCT documents have thumbnail images available

Analytics Reports - click the Images worksheet checkbox to report selected patent
images into an Excel worksheet (up to 200 patent documents)

Cite View and Examination Data View - click the checkboxes under the images
section to include images in these views
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PatentOptimizer™ Analytics Report

Select the options you would like to use in generating a new Microsoft®  Excel or Microsoft®  Word report.

You can launch the PatentOptimizer™ Analytics Report feature by clicking the Report button on the PatentOptimizer™
Analytics dialog box.

The following image shows the Analytics Report dialog box.

Value Description

Include Select one of these options:

Filter Tabs Area (top portion of the dialog box)

All Items - All items that were retrieved are included in the report

Filtered Subset - The items that are interrelated by the currently selected filter(s) are
included in the report

Selected Items Only - Only the filter items that are selected are included in the
report, not the interrelated items. That is, if you have selected one Claim Element
and one item under People & Org, only those two items will appear in your report

View Tabs Area (lower portion of the dialog box)

Selected Pubs/Docs - Each of the publications/documents you selected is included
in the report

Show Class Descriptors Select to show class descriptors in the report.
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Worksheets tab

Value Description

Sel Select the check box(es) that correspond to the other columns in this table.

Item Lists the different options available for you to select.

Worksheet Name Click to enter a custom name.

Select All Click to select all of the check boxes in the Sel column.

Deselect All Click to clear all of the check boxes in the Sel column.

OK Click to generate a Microsoft®  Excel spreadsheet report.

Cancel Click to close the dialog box without saving any changes.

Chart 1 through 5 tabs

Value Description

Categories Only Select this option if you only want categories (not Categories Plus Values) to be
displayed in your report. Then use the Sel check boxes to pick the listed category you'd
like to include.

Categories Plus Values Select this option if you want to include values in your report. Then use the Sel check
boxes to pick the listed category you'd like to include.

Include "Other" Select to include a summary "Other" value in your report.

Chart Name Enter the name of your chart.

Chart Type Select whether you'd like the chart to be Stacked or Clustered.

The following is an example preview of a report with a Stacked chart type:

The following is an example preview of a report with a Clustered chart type:
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Max Categories Select a value from 10 to 50 from the drop-down list.

Max Values Select a value of 5, 10, 15, or 20 from the drop-down list.

Preview Layout Click for a preview of how the data will be displayed on the chart.

OK Click to generate a Microsoft®  Excel spreadsheet report.

Cancel Click to close the dialog box without saving any changes.
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Claim Chart

Use the Claim Chart dialog box to select which options you'd like to include in a Claim Chart report that will be generated
in a new Microsoft Excel or Microsoft Word window.

You can launch the Claim Chart dialog box by clicking the Claim Chart button on the Check Claims or PatentOptimizer™
Analytics dialog boxes.

The following images show the Claims Chart dialog box when launched from the Check Claims and Analytics dialog
boxes, respectively.

Claims Chart dialog box launched from the Check Claims dialog box

Claims Chart dialog box launched from the Analytics dialog box

Value Description

Included Claims Select one of these options:
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All Claims

Range - Available only when the Claim Chart button is clicked from the Check
Claims dialog box. Enter the range of claims you want to create a report for,
separating discontinuous numbers with either a comma or a semicolon. For
example: 2-3;5

Independent Claims Only

Add Select any of these options to add columns to the report:

Separate List of Elements - Lists out claim elements in series of rows located in new
column next to related claim

Part Numbers - Includes part numbers of elements in separate column, next to
claim/elements. The part numbers appear in their own column, immediately next to
their related claim elements.

Prior Art Reference Data - Available only when the Claim Chart button is clicked
from the Check Claims dialog box. Includes information from Reference Tabs of
Check Claims. This data will be included in the same row as the claim, with text
first, followed by Biblio data, just as it currently appears in the check claims report.
If a prior art reference is related to an element, the element will be called out in the
report.

Support in Disclosure - Available only when Separate list of Elements is selected
on the Check Claims dialog box - displays the context and location of the claim
element in the specification.

Claim Format Select one of these options to customize your claim text:

Full Text - Selecting this will display the full claim text will appear in the Claim Text
column of your report

Partitioned - Selecting this will break out claims into separate rows based on
semicolon separations

Other Options Select any of these other options:

Re-number in Sequence - Numbers all claims in numerical sequence. For example,
if you have selected Independent Claims only and these are claim 1, claim 4, claim
8, when you select this option will they be called claim 1, claim 2 and claim 3 in the
report.

Add Element Bolding - Bolds elements appearing in the claims

Insert Part Numbers - Inserts part numbers directly into text of the claims

OK Click to save your changes and close this dialog box.

Cancel Click to close the dialog box without saving any changes.
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PatentOptimizer™ Analytics
Use the PatentOptimizer™ Analytics feature to run an analytics profile for U.S. utility patents and PCT applications
meeting your specific criteria (the cite list you've searched for, predetermined patent citations, or local documents you've
imported). Once you click the Profile tab, you can interact with the subsequent filter (those across the top of the dialog
box) and view (those across the bottom) tabs to refine what you're seeing, and then run a Report, Claim Chart, or Check
Refs on your results.

You can launch the PatentOptimizer™ Analytics feature by clicking the Analytics button ( ) on the LexisNexis

PatentOptimizer toolbar of Microsoft®  Word or Internet Explorer.

Note:
If you do not have access to this feature, a pop-up window will be displayed when you click the button, informing you of
this fact. Contact your Account Representative if you would like to activate the Analytics feature.

Common Buttons and UI Elements

The common buttons appear at the bottom of the dialog box.

Tip:
You can combine at least 2 items in any category of information (e.g., People & Org > Assignee, or Inventor, or Legal
Rep) to make the display less cluttered. To combine them, select at least 2 check boxes, then right-click and select
Combine Selected from the resulting menu. Then choose the label you want to use for these combined items and
how long you want this substitution to remain in effect ("This Session Only" or "Permanent"). To undo the combination,
click the Options subtab for Analytics, then either click the Remove All button to remove all combinations, or select
one combination then click the Remove button to remove it.

Value Description

Select All Click this button to select all of the items listed in the selection table at the bottom of the
Profile tab.

Deselect All Click this button to clear all of the check marks from the items listed in the view tabs at
the bottom of the Profile tab.

Report Select Analytics Report to open the PatentOptimizer™ Analytics Reports dialog
box, or select Pub/Doc Summary to open the PatentOptimizer™ Analytics Summary
Report. Select the items that you want in the report, and select any filters to be used in
creating your report in a new Microsoft®  Excel or Microsoft Word window.

Claim Chart Click to open the Claim Chart dialog box, then select which options you'd like to include
in this report in a new Microsoft Excel or Microsoft Word window.

Check Refs Click to open the Check References dialog box.

Tip:
if you haven’t selected any patents, then all patents will be analyzed.

Close Click to close this dialog box.

Help Click to view help specific to this feature.
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Source tab

The source tab identifies sources for patent data to be analyzed. You can provide your own list of patents (with or without
titles), specify a file folder for patents, or run a search based on criteria you enter.

The following image shows the Analytics dialog box displaying the Source tab before a search has been run.

Once you enter the values you want to search on and click the Run Analytics Profile tab, the Patents that match your
search criteria are displayed.

The following image shows the Analytics dialog box displaying the Source tab after a search has been run.
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Value Description

My Documents tab This tab allows you to import up to 1,000 Microsoft®  Word documents to be analyzed.

Open Click to retrieve a list of sources you've previously saved.

Save Click to save the sources listed, so you can open them and work with them again later.

Import Click to Browse for a folder that contains the patents you'd like to analyze, then click OK
to complete the import.

Tip:
Once you have imported the documents, you can select and delete individual
documents before you click the Run Analytics Profile button.

Search tab This tab allows you to enter search criteria to find patents whose profiles you want to
view.

Open Click to retrieve a list of sources you've previously saved.

Save Click to save the sources listed, so you can open them and work with them again later.

Search Click to search for patents that meet all of the criteria you've entered. You must click this
button before clicking the Run Analytics Profile button.

Clear Click to clear all of the criteria you've entered.
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Max Docs Select a value from the drop-down list. The fewer documents you analyze, the faster the
analysis will be run. Choosing a larger number may result in an error message being
displayed when you click the Run Analytics Profile button to warn you that some items
may not be shown in the results.

Doc Type Select a value from the drop-down list:

All

Granted

Applications

Authority Select either or both of these options:

US - United States

WO - World Intellectual Property Organization (WIPO)

Class Enter the main U.S. patent classification number in this box to limit the range of your
search to a particular class/subclass of patents.

Tip:
Identify subclass with a # sign.

Example:
229#112

IPC Enter the International Patent Classification number.

Tip:
Identify subclass with a # sign.

Example:
B65D 043#14

Assignee Enter a person or company name for the assignee at issue.

Legal Rep Enter the name of the legal representative (individual or company name).

Inventor Enter the name of an inventor.

Ref Cited Enter the citing reference you want to find.

Date Range Select a predefined date restriction from this drop-down list:

No Date Entered

Previous Week

Previous Month

Previous 3 Months

Previous 6 Months

Previous Year

Previous 2 Years

Previous 5 Years

Previous 10 Years

Date From Select the option for From date, then choose the date you want to use by either:

Entering the date in the box in MM/DD/YY format
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Clicking the corresponding calendar button ( ) and selecting a date

Date To Select the option for From date, then choose the To date you want to use by either:

Entering the date in the box in MM/DD/YY format

Clicking the corresponding calendar button ( ) and selecting a date

Run Analytics Profile Click to analyze the displayed Patents.

A performance warning message may display to alert you that all parts, claim
elements, terms, phrases and citations found in only one patent will not be shown

Click OK to continue.

Important:
The analysis takes about 1 second per patent.

Tip:
To increase performance speed and performance, and disable this warning message,
reduce the number of patents to be analyzed, or navigate to the Options tab and
adjust the Optimize Results setting.

Cancel Click to cancel a Run Analytics Profile command.

Patents Lists the patents you entered, that were found when you clicked the Search button on the
Search tab, or that you Imported on the My Documents tab.

Tip:
When you enter patent numbers directly into this box, they must be entered on
separate lines to be correctly detected by the tool.

Important:
Review the patent citations listed in this box, then select and delete any items you do
not want to include in your analysis.

Summary Reflects totals and averages of the analyzed data:

Item - Lists the type of item that was analyzed (e.g., Claims, Inventors, Examiners)

Average - Lists the average number for each item

Total - Lists the total number for each item

Unique - Lists the number of unique instances for each item
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Profile Tab

The profile tab contains the patent analysis results.

The following image shows the Analytics dialog box displaying the Profile tab.

Value Description

Clear All Click this to clear all selections made across all of the Profile filter tabs.
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Filter Tabs

The filter tabs across the top are joined together with Boolean AND logic; within each filter, selections are ordered. All hits
are identified with total counts, in rank order (highest to lowest). Selecting a value results in filtering of data in the bottom
half of the display. The filter data not contained in an answer set in the filter tabs is grayed out.

Tip:
To apply "AND" logic within each filter tab as well as across filter tabs, select the Apply "AND" Logic check box in the
Options filter tab.

For example, selecting options from the different filters across the top treats each additional selection as a
Boolean AND.

New!  Auto sorting now takes place after you select a check box. That is, when you select a check box from anywhere in
the list, it automatically moves to the top of the list.

Example:
Selecting multiple check boxes within a single filter treats each additional selection as a Boolean OR.
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Value Description

People & Org Displays check boxes and Count [Cnt] columns as applicable for the patents being
analyzed. For example:

Assignee

Inventor

Legal Rep

Examiner

Auto-Sort Filters

Class & Date Displays check boxes and Count [Cnt] columns as applicable for the patents being
analyzed.

Tip:
If you rest your pointer over a value in the US Class column, the description for that
class (and subclass) will be displayed. To control whether both the class and subclass
or just the class is displayed, click the Options tab and select your desired display
option under US Class Display.

US Class

IPC

Filed Date
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Pub Date

Auto-Sort Filters

Specification Displays check boxes and Count [Cnt] columns as applicable for the patents being
analyzed. For example:

Parts

Terms

Phrases

Citations

Auto-Sort Filters

Claim Elements Displays check boxes and Count [Cnt] columns for aggregate claim elements across all
of the profiled documents. For example:

Claim Elements, with Variants (which are algorithmically derived from your selected
portfolio of patents)

Tip:
If you select a Claim Element that has Variants, the table to the right lets you
select any Element Variants you wish.

Use these options at the right to further filter your results, if desired.

Limit Element Variants to Doc Claim Language

Locate and Display within
o All Claims - identifies documents when selected elements appear anywhere in

the claim set
o Independent Claims - identifies documents when selected elements appear

anywhere in a single independent claim
o Auto-Sort Filters - automatically sorts results, placing the most relevant results

at the top of the list

Definitions Displays check boxes and Count [Cnt] columns for Term and Definition columns.
The Definitions provided here are mined from express glossaries contained in various
patents. These glossaries typically have a heading (such as GLOSSARY :) followed by a
series of terms with definitions.

Auto-Sort Filters - automatically sorts results, placing the most relevant results at the top
of the list

Thesaurus Displays check boxes and Count [Cnt] columns as derived from parts data located in your
selected patent portfolio. For example:

Term/Phrase, with Variants

Tip:
If you select a Term/Phrase that has Variants, the table to the right lets you
select any Term/Phrase Variants you wish.

Auto-Sort Filters - automatically sorts results, placing the most relevant results at
the top of the list

Thesaurus items are determined by identifying parts having name variants for the same
part number as across multiple patents.
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Selection Summary Displays summary check boxes for viewing selections and overriding individual filters. For
example:

Selection

Attribute

Auto-Sort Filters

When you select or clear one or more of the Sel check boxes, a dialog box appears
when you try to leave this tab, asking you if you want to "Update filters with selection
changes?". Click Yes to save the changes you've made.

Options Select from the following options, as desired:
Filters

Counts | Filter Counts Only - Select to reflect counts that identify the subset defined
by your filter selections

Specifications > Terms | Ignore Common - Select to ignore common terms
appearing in terms filter

Standardization | Enable - Select to enable entity standardization across filters

US Class Display | Class or Class/Sub-Class - Select to enable US class display
filters or display class/subclass filters

Apply "AND" Logic - Select one or more check boxes for the type of filter (List) to
which you would like to have AND logic applied, instead of the typical OR logic
within each filter tab

Combined Entities

Caution:
The changes you make will be reflected in your next session - not in the current
Profile results

o <Add> - Select to add a new combined entity
o Edit - Select an item in the list, then click to modify that combined entity. The

Combine Entities dialog box has these options:
- <Add> - Select to add a new combined entity
- OK - Click this button to save the changes you've made and exit this

dialog box
- Cancel - Click this button to cancel the changes you've made and exit

this dialog box
- Edit - Click this button to modify the name of the item you selected
- Delete - Click this button to remove the item you selected from the list of

combined entities
- Duration - Select either Permanent or This Session Only

o Delete - Select an item in the list, then click to delete that item

Global

Optimize Results - Select one of these options from the drop-down list:

Optimize Results option

Maximum Documents value can be applied to:
o None
o >0 - 24
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o Ignore Single Count
o 25 - 249
o Ignore 2 or Less
o 250 - 499
o Ignore 3 or Less
o Ignore 4 or Less
o 1000-1500
o Ignore 5 or Less
o 1500-2000

Cache Offline - Click the checkbox to cache from your local disk drive, instead of
caching records from a server

Clear Cache - Click the checkbox to remove all saved patent data from the
Analytics feature

Views
o Independent Only - select the Independent Only check box to view

independent claims only in the Claims view tab
o Add Part Nos. to Claims

Tip:
Since data will accumulate on your disk drive, you should clear the cache periodically
to increase performance speed and decrease disk space usage.
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View Tabs

The view tabs show the results you get once you have applied filters using the filter tabs at the top of the dialog box.

Select one or more check boxes in the view tabs that you want to run a Report, Claim Chart, or Check References on.

Value Description

Cite Select one or more items based on the columns displayed:

Pub Number - Publication Number

Title

IPC

Assignee

Granted Date

The documents displayed are subject to your selections in the filter tabs.

Examination Data Select one or more items based on:

Pub Number - Publication Number

Title

US Class

Legal Rep - Legal Representative

Inventor

Examiner

Ind Clms - Independent Claims

Claims

Claims Select one or more publication numbers, then use the Claim Tree and Claim Text boxes
to the right to navigate and view the associated claim hierarchy and text.

Full Text Select one or more publication numbers, then use the box to the right to review the full
plain text for your selections.

Images View and manipulate thumbnail images that are available within the selected patent
documents:

o US documents have thumbnail and drawing sheets available
o PCT documents have thumbnail images available

Analytics Reports - click the Images worksheet checkbox to report selected patent
images into an Excel worksheet (up to 200 patent documents)

Cite View and Examination Data View - click the checkboxes under the images
section to include images in these views
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How do I insert a formatted patent citation?
Important:
This task can only be performed in a Microsoft®  Word document.

 

1. Position your cursor where you want to insert the citation into your patent document.

2.
Select Citation ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

3. Select the applicable category for the patent you want to cite from the Type drop-down list.

4. Type the full patent Number in the corresponding field.

5. Click Get Patent Info.

6. Select the desired citation format from the Cite Format drop-down list.

7. Click Insert.
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How do I create a citation format?
Important:
This task can only be performed in a Microsoft®  Word document.

 

1.
Select Citation ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Click Add/Edit Cite Formats.

3. Create a new citation format by highlighting an existing format, then clicking Copy.

4. In the Edit box, modify the name of the newly created format as desired.

5. In the lower pane, modify the definition for the newly created format by changing the text and punctuation outside of
the bracketed material or the order of the bracketed material.

6. Click Preview to view a sample citation using the new format in the lowermost pane.

7. Click Save to save the citation format.

Tip:

To reorganize all but the default citation format in order of preference, click the listing for a citation format
that you want to move, then click the Up Arrow or Down Arrow until the selected listing is in the desired
position

To permanently remove a citation format, select the corresponding listing, then click Delete
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How do I view claim structure?
1.

Select Check Claims ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Click the Claim Tree tab.

The Claim Refs pane of the tab illustrates the structure of your document’s claims section in tree format, with each claim
listing constituting a separate branch indented and assigned an icon per the claim's relationship status.

For further information, see How do I view claim relationships? in the User's Guide.
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How do I research claim elements on the Internet?
1.

Select Check Claims ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Select the Elements check box. The Claim References pane refreshes to display a list of elements beneath the
branch for the claim in which they appear in the claims section of your patent document.

3. In the Claim References pane, choose the listing for the claim for which you want to research elements.

4. Click Search Claims.

5. In the Search area, choose the tab for the type of search you want to perform (e.g., lexis.com® , Scopus® , or The
Web).

6. As applicable based on the type of search being performed, choose the specific source you want to search from the
list in the Search area pane (e.g., choose a search engine for the Web).

7. If you want to run a semantic analysis before your search, click:

The Apply Semantic Analysis button to run a semantic query against the terms in the Claim Elements list

The check box in the Sel column to specify which terms will be used in your search

The Previous ( ), Rerun Query ( ), and Next ( ) buttons if you want to view other search term sets or
rerun the query

Incl or Excl next to an item to include (Boolean AND) or exclude (Boolean AND NOT) that term

An item's Weight number to change it (1=low prominence, 2=medium prominence, 3=high prominence) for
your search

8. Click Search to perform the search and review the results.

Tip:
You may save material associated with your search for and associate it with a specific claim or element. For
details on doing so, see How do I research claim elements? in the User's Guide and, specifically, steps 12
through 14 of that procedure.

researchclaimelementsug_hdi.html#researchclaimelementsug_hdi__12
researchclaimelementsug_hdi.html#researchclaimelementsug_hdi__14
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How do I compare multiple patent documents?
1. Open the first document that you want to compare.

2.
Click the Compare Docs toolbar button ( ), then click OK.

3. Open the next document that you want to compare.

4.
Click the Compare Docs toolbar button ( ). The Compare Docs dialog is displayed, indicating which other
documents are designated for comparison.

5. Proceed as applicable based on the desired course of action:

To compare the documents designated up to this point, click Compare Now. The Compare Docs window
opens. Proceed to step 6.

To designate additional documents for comparison, repeat steps 3 and 4 for each such document.

To negate the designation for comparison of the most recently opened document, click Cancel, then step 5.

6. Compare the chosen documents by reviewing the information displayed in the Compare Docs window.

Note:
For further information, see How do I compare patent documents? in the User's Guide.
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How do I verify antecedent basis?
1.

Select Check Claims ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Click the Antecedent Basis tab. The tab displays a table listing elements appearing in the document along with
codes and icons denoting status pertaining to antecedent basis.

Note:
For further information, see How do I verify antecedent basis in a patent document? in the User's Guide.
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How do I assess language consistency in a patent document?
1.

Select Check Claims ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Click either the Terms or Phrases tab. The tab displays a table listing either the terms or phrases found in the
description and claims sections of your patent document.

Note:
If you find inconsistencies in language usage, you can navigate to the corresponding material in your document
directly from the Check Claims dialog box, then post the desired corrections. For details on doing so, see How do
I assess language consistency in a patent document? in the User's Guide (specifically, steps 6 through 8).

assesslanguage_hdi.html#assesslanguage_hdi__6
assesslanguage_hdi.html#assesslanguage_hdi__8
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How do I programmatically mark claims and claim references?
Important:
This task can be performed only in a Microsoft®  Word document.

 

1.
Select Mark Claims Wizard ( ) from a LexisNexis®  PatentOptimizer™ menu or toolbar.

2. When the tool has found the start of your claims section, click Yes in the displayed prompt.

3. When the tool has found a claim or claim reference, click Yes in the displayed prompt.

Tip:
Marking claims and claim references allows you to both verify numbering and automate renumbering in the
event that you add, move, or remove claims. For further details on using this feature, see How do I verify claim
numbering and referencing? in the User's Guide.
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How do I detect part-labeling inconsistencies?
1.

Select Check Parts ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Review the displayed information, using the following as a reference in doing so:

The Parts Index pane on the Check Parts tab displays in numerical order each occurrence of identified part
numbers along with the part name corresponding to each part-number occurrence, allowing you to easily see
any part numbers associated with multiple part names

To see which if any part names are associated with multiple part numbers, click Find Repeated Parts

Tip:
For further details on using this feature, see How do I find part-labeling inconsistencies? in the User's Guide.
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How do I correct part-labeling inconsistencies?
Important:
This task can only be performed in a Microsoft®  Word document.

 

1.
Select Check Parts ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. In the Check Parts dialog box, click Edit to open the Edit Parts dialog box.

3. In the list of part labels, select one or more labels for which you want to post corrections.

4. Indicate the desired changes, using the following as a guide in doing so:

To assign a different name to the selected part labels, type the desired name in the Replace selected with
field within the Names area.

To assign a single new number to the selected part labels, select New Number from the Replace selected
with drop-down list in the Numbers area, then type the desired number in the field beside the drop-down list.

To assign a range of new numbers to multiple selected part labels, first select Range starting at from the
Replace selected with drop-down list in the Numbers area, next type the starting number of the desired range
in the field beside the drop-down list, then select the increment by which you want to increase the numbers of
the selected part labels numbered progressively higher than the starting part label.

Tip:
For further details on renumbering part labels across a range, see How do I correct part numbers associated with
multiple part names? in the Users Guide (specifically, steps 5 through 7).

5. Click Preview button to review your changes before updating your document accordingly. New columns showing
your changes are added to the table displayed in the Edit Parts dialog box.

6. Begin posting part-labeling corrections to your document by clicking OK and then clicking either Replace (to post
corrections one at a time after reviewing each) or Replace All (to post all corrections at once without having the
opportunity to review them first) in the displayed dialog box.

Tip:
See How do I correct part-label inconsistencies? in the User's Guide.

correctpartnumbers_hdi.html#correctpartnumbers_hdi__5
correctpartnumbers_hdi.html#correctpartnumbers_hdi__7
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How do I insert part labels using placeholders?
Important:
This task can only be performed in a Microsoft®  Word document and requires that the name and number for the
applicable part label be spelled out at least once in the document.

In situations where you must denote a lengthy part label numerous times in a patent document, the LexisNexis®

PatentOptimizer™ service can ease the process, requiring you to designate the applicable label only once, after
which you can type a single short placeholder at all other necessary places in your document then have the service
automatically substitute the designated part label for all instances of the placeholder.

Note:
To address varied user preferences, the LexisNexis PatentOptimizer service allows you to modify the default
placeholder prefix (see How do I change the prefix designating placeholders?.

1. In the Microsoft Word application, open the desired patent document.

2. At each location within the abstract, claims, and/or detailed description section where you want to insert the part
label using a placeholder, type placeholder information using the following convention (substituting actual data for
the bracketed material and omitting the brackets):[part prefix][number of part being used]
The default placeholder prefix is fp. So to insert a placeholder for part 104, you would type fp104. Note that there
should be no spaces between the part prefix and part number and that this functionality is not case sensitive.

3.
Select Check Parts ( ) from a LexisNexis PatentOptimizer menu, toolbar, or right-click menu.

Tip:
If the service displays a message stating that the detailed drawing description section could not be found instead
of displaying the Check Parts dialog box, you may have given the section a heading that the Check Parts feature
doesn't recognize (for example, you may have used the abbreviation "DRWGS DESCR"). To fix this, see How do
I specify unique variations in wording of section headings?, specifically entering your chosen wording in Detailed
Description of Drawings.

4. Click the Insert Names tab to view all placeholders appearing in your document. The Part Place Holder pane
displays a list of all placeholders identified in your document in table format along with suggested part-label
substitutions.
The following image shows the Check Parts dialog box displaying the Insert Names tab.
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5. Review the suggested part label for each placeholder, then proceed as applicable based on the desired course of
action:

To change a suggested part label, proceed to step 6.

To proceed without changing any suggested part labels, proceed to step 10.

6. In the Part Place Holder pane, click the rows corresponding to the placeholders for which you want to change the
suggested part label. The row is highlighted.

7. Click within the Suggested column in the highlighted row. The corresponding field becomes editable.

8. Type the desired part label in the box.

9. Change additional suggested part labels or proceed without doing so, as desired:

To change additional suggested part labels, repeat steps 6 through 8.

To proceed without changing additional suggested part labels, go to step 10.

10. In the Part Place Holder pane select the listings corresponding to the placeholders for which you want to substitute
part labels.

Tip:
You can select multiple consecutive or non-consecutive placeholders at once, as follows:
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To select multiple consecutive placeholders, click the listing corresponding to the first desired placeholder,
then press and hold the SHIFT key, next click the listing corresponding to the last desired placeholder, and,
finally, release the SHIFT key

To select multiple non-consecutive placeholders, click the listing corresponding to the first desired
placeholder, then press and hold the CTRL key, next click each listing corresponding to the remaining
desired placeholders, and, finally, release the CTRL key

11. Click Insert. A message is displayed, citing the number of part labels to be inserted and informing you that any
changes made can be negated using the Edit/Undo command in the Microsoft Word application.

12. Click OK to close the message and substitute the part labels for the selected placeholders in your patent document.

13. When you have finished inserting part labels, click Close.
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How do I number unnumbered parts in the Abstract, Claims, and Detailed
Description sections?

Important:
This task can only be performed in a Microsoft®  Word document.

 

1.
Select Check Parts ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. Select the Insert Numbers tab to view a list of all parts missing part numbers in the abstract, claims, and detailed
description sections. The tab displays in table format a list of parts lacking part numbers along with suggested
numbers for the parts, presented per analyzed document section.

3. In the Invalid Parts pane, select the part labels that you want to number in your document, then click Insert.

4. Begin posting part-numbers to your document by clicking the OK button in the displayed message and then clicking
either Replace (to insert numbers one at a time after reviewing each) or Replace All (to insert all numbers at once
without having the opportunity to review them first) in the displayed dialog box.

Tip:
For further details on using this feature, including editing part numbers before inserting them, see How do I insert
missing part numbers? in the User's Guide.
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How do I refine commonly used measurements?
Important:
This task can only be performed in a Microsoft®  Word document.

1.
Select Check Measurements ( ) from a LexisNexis PatentOptimizer menu or toolbar. The Check Measurements
dialog box opens, displaying in table format a list of all detected commonly used measurements appearing within the
document along with suggested substitutions.

2. Click to select the measurements you want to replace.

3. Click Replace to replace the measurements with the suggested measurements. A message is displayed, prompting
you to confirm your desire to replace the selected measurements with the suggested alternate measurements.

4. Click OK to close the confirmation message and replace the selected measurements are with the suggested
alternate measurements in your patent document.

Tip:
For further details on using this feature, see How do I refine commonly used measurements? in the User's Guide.
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How do I view information on referenced patents?

Select Check References ( ) from the LexisNexis®  PatentOptimizer™ toolbar or menu.

The Check References dialog box opens and display information related to each patent referenced in your document.

Tip:
For further details on using this feature, see Analyzing Referenced Patents in the User's Guide.
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How do I generate reports?
By clicking the Report button in the dialog boxes listed below you can generate documents outlining corresponding
information related to your patent documents, as follows:

Dialog box Report information

Check Terms Prior usage

Case reference

Alternate suggested terminology

Custom definitions for terms or phrases that you selected before clicking the Report
button

Check Claims Claim errors

Number of claims

A claim tree and/or chart

Reference bibliographic data

Terms and/or phrases found in the claims section but not the description section

Term and/or phrase usage in claims

Antecedent basis

Compare Docs Documents that you compared

The elements, terms, and/or phrases that were changed between documents and
the documents in which the changes occurred

The claim structure of each compared document

Check Parts Identified part numbers and names

Part names associated with multiple part numbers, ordered alphabetically

Unnumbered parts organized by section (i.e., abstract, claims, and detailed
description) and ordered per occurrence in the document

Any designated placeholders and corresponding part name and number

Check References Post-issuance activity and ownership information for referenced patents that you selected
before clicking the Report button

Check Measurements Current measurements along with corresponding suggested alternatives, if any

Profile Analytics Report
o Available after running the Analytics Profile from the Source tab
o May include thumbnail images in the Cite View or Examination Data View

Pub/Doc Summary Report
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How do I define section heading aliases?
In extracting information to perform functions, the service looks for predefined wording to identify sections in patent
documents. You can, however, set the program to recognize sections based on unique, user-defined wording.

1.
Select Options ( ) from a LexisNexis®  PatentOptimizer™ menu, toolbar, or right-click menu.

2. In the Options dialog, select the Section Headings tab.

3. For each document section for which you want to specify one or more heading aliases, type the desired wording in
the corresponding pane.

Tip:
To define multiple aliases for a given section, press the ENTER key between entries.

4. When you are finished, save your input and close the Options dialog box by clicking OK.
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How do I deactivate the LexisNexis®  PatentOptimizer™ Service?
Note:
You must have an active Internet connection to perform this task.

Your license for the LexisNexis®  PatentOptimizer™ service allows you to use the software on one computer. You can,
however, deactivate the service on one computer when you want to use it on another computer.

1. Open the Microsoft®  Word, Internet Explorer, Adobe Acrobat® , or Adobe Reader®  program as you normally would.
The applicable program opens, displaying the LexisNexis PatentOptimizer in the upper portion of the program
window.

2.
Select Options ( ) from a LexisNexis PatentOptimizer menu, toolbar, or right-click menu. The LexisNexis(R)
PatentOptimizer(TM) Options dialog box opens.

3. Select the Updates and Deactivation tab.
The following image shows the Options dialog box displaying the Updates and Deactivation tab.

4. Click Deactivate. A dialog box opens, prompting you for your LexisNexis®  User ID and Password.

5. Enter your LexisNexis®  User ID and Password.

6. Click OK. The dialog box closes and a message is displayed, indicating that the service has been successfully
deactivated.

7. Click OK to close the message and return the focus to the Options dialog box, where the Deactivate button is now
unavailable.
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How do I store client matter IDs?
1. Open the Microsoft®  Word, Internet Explorer, Adobe Acrobat® , or Adobe Reader®  program as you normally would.

2.
Select Options ( ) from a LexisNexis PatentOptimizer menu, toolbar, or right-click menu. The LexisNexis(R)
PatentOptimizer(TM) Options dialog box opens.

3. Click the Manage Client Matter IDs tab. The Manage Client Matter IDs tab of the Options dialog box opens (as
shown below).

4. Click Add. A new empty entry with a blinking cursor appears.

5. In the empty entry, enter the applicable client matter ID.

Tip:
If a specific format is required for the client matter ID, that format will be illustrated in the area just beneath the list
of client matter IDs.

6. When you are finished entering the client matter ID, press the ENTER key or click elsewhere within the dialog box.

Tip:
By default, client matter IDs are listed in reverse chronological order, that is, with the most recently stored client
matter ID listed first.

The client matter ID list refreshes to reflect the addition of the client matter ID.

7. Repeat steps 4 through 6 for each client matter ID you want to store.

8. When finished storing client matter IDs, save your input and close the Options dialog by clicking OK.
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Tip:
For instructions on editing or deleting previously stored client matter IDs, see How do I track billable activity by
client?.
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How do I track billable activity by client?
Before You Begin:
Before tracking billable activity, you must store IDs for your clients.

As an aid in determining client billing charges, the LexisNexis®  PatentOptimizer™ service provides a tracking mechanism
for certain analysis and report activities performed by the service on a given day. In tracking billable activity, the
LexisNexis PatentOptimizer service interfaces with the PowerInvoice™ service, from which you can generate monthly
reports detailing the following information:

Web ID of the staff member who performed the activity

ID of the client for whom the activity was performed

Date of service

Service used to perform the activity

Billable analysis activity or report activity

Activity is tracked on a daily basis, with activity for a given date, Web (user) ID, client ID, and task on a given date being
combined into a single report record for that date.

Important:
Whenever you perform a billable activity using the LexisNexis PatentOptimizer service while online, tracking
information is sent to the PowerInvoice program in real time. If for some reason during a given month you elect to use
the LexisNexis PatentOptimizer service offline, billable-activity information will be stored locally until you again use the
service while online — which you must do before 10:00 p.m. E.S.T. of the last day of the month if you want the stored
information to be included in the report for that month.

To speed entry while also ensuring consistency and, thus, accuracy of client matter IDs from session to session, the
program provides for storage of this information. Once stored, client matter IDs can be modified as necessary. Should a
client matter ID for some reason become obsolete, you can delete it from storage.

1. Open the desired document in Microsoft®  Word, Internet Explorer, or Adobe Acrobat®  as you normally would.

2. Initiate the activity tracking process in one of the following manners, as applicable:

If your lexis.com®  ID is configured for mandatory entry of client matter IDs, and you have not previously
selected a client matter ID against which to track activity since last opening the Microsoft Word, Internet

Explorer, or Acrobat program, click the toolbar button for the billable activity that you want to perform [i.e., 

(Check References),  (Check Terms),  (Mark Terms),  (Check Measurements),  (Check Parts),

 (Check Claims),  (Compare Docs),  (Patent Citation), or  (Mark Claims Wizard)]. The Client
Matter ID Selection dialog is displayed.

If your lexis.com ID is configured for mandatory entry of client matter IDs, and you have previously selected a
client matter ID against which to track activity since opening the Microsoft Word, Internet Explorer, or Acrobat
program on the given day, or if your lexis.com ID is not configured for mandatory entry of client matter IDs, click

Assign Applicable Client Matter ID ( ) on the toolbar. The Client Matter ID Selection dialog is displayed.

3. In the Client Matter ID Selection dialog box (shown below), choose the entry corresponding to the client for whom
you are performing the activity.

Tip:
If you do not want to track activity for a particular client, choose the <none> entry.

Note:
By default, client matter IDs are listed in reverse chronological order, that is, with the most recently stored client
matter ID listed first.
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4. Click OK. The Client Matter ID Selection dialog closes, and you should proceed as applicable.

If at step 2 of this procedure you clicked the toolbar button for the billable activity that you want to perform,
proceed directly with the activity. The service will track the activity being performed against the chosen client
matter ID.

If at step 2 of this procedure you clicked the Assign Applicable Client Matter ID button, now click the toolbar

button for the billable activity that you want to perform [i.e.,  (Check References),  (Check Terms), 

(Mark Terms),  (Check Measurements),  (Check Parts),  (Check Claims),  (Compare Docs), 

(Patent Citation), or  (Mark Claims Wizard)]. The service will track the activity being performed against the
chosen client matter ID.

Important:
Client matter ID selection remains active until either you close the program (Microsoft Word, Internet Explorer, or
Acrobat) or you choose a different client matter ID.
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Technical Support
Technical Support is available 24 hours a day, 7 days a week. When calling for technical assistance, please have your
user ID ready and be at the computer on which the program is running.

Phone: 1-800-543-6862 (U.S. and Canada)

Web: http://www.lexisnexis.com/custserv/

http://www.lexisnexis.com/custserv/


LexisNexis® PatentOptimizer™ Quick Reference Card 09-27-2012

68

Copyrights
LexisNexis, Lexis, the Knowledge Burst logo, and lexis.com are registered trademarks of Reed Elsevier Properties Inc.,
used under license. PowerInvoice is a trademark of LexisNexis, a division of Reed Elsevier Inc. CourtLink is a registered
trademark of LexisNexis CourtLink, Inc. HotDocs is a registered trademark and HotDocs Player is a trademark of
HotDocs Limited. Adobe Acrobat and Adobe Reader are registered trademarks of Adobe Systems Incorporated. Microsoft
and Windows are registered trademarks of Microsoft Corporation. Other products and services may be trademarks or
registered trademarks of their respective companies.

Copyright 2012 LexisNexis, a division of Reed Elsevier Inc. All rights reserved.
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